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1.0    The Main Program
The Napoleon in Russia Main Program is normally invoked by double clicking on a scenario 
icon. The scenario icon executes the main program and passes to it the name of a subdirectory 
containing the scenario information.

At startup, the main program loads the map files and certain data about the units such as order-
of-battle information. After the main program is invoked, a battle can be loaded by using the 
New menu item under the File Menu. If the Prompt for Scenario option under the Options Menu 
is in effect, then the new scenario dialog will automatically be displayed allowing a new battle to
be loaded.



1.1    The Menus
These menus are associated with the Napoleon in Russia program:

    1.1.1    The File Menu
    1.1.2    The Phase Menu
    1.1.3    The Units Menu
    1.1.4    The Melee Menu
    1.1.5    The Reinforce Menu
    1.1.6    The Status Menu
    1.1.7    The Display Menu
    1.1.8    The A/I Menu
    1.1.9    The Special Menu
1.1.10    The Options Menu
1.1.11    The Help Menu



1.1.1    The File Menu

The File Menu is used to start new battles and to load and save previously started battles.

To start a new battle, Select the New menu item. A file selection dialog will appear so that the 
starting scenario can be selected. By convention, a starting scenario has the extension .scn. Once 
a starting scenario has been selected, certain initialization is performed such as the initial 
command determination and the arrival of reinforcements for the first turn.

To load a previously saved battle, Select the Open menu item. A file selection dialog will appear 
so that the file name of the battle can be specified. By convention, a battle file has the extension
.btl.

To save a battle that has been started new or loaded from a file, Select the Save menu item. If the 
battle has never been saved, a file selection dialog will appear so that the file name of the battle 
can be specified. A battle file should be saved under a file name with extension .btl. Note: in 
general it is a good idea to save a battle periodically and not wait until exiting before saving the 
battle. Saving the battle protects against its loss due to accidents such as power failures and 
allows for recovery in the event of a mistake in the use of the program.

The Save As menu item can be used to save a battle under a file name other than the one 
currently being used for the battle. This allows the current state of a battle to be saved in another 
file without affecting the file being used for the battle.

The Snapshot menu item can be used to save a map of the current situation, including the 
currently spotted units, to a file. A file selection dialog will appear so that the file name of the 
bitmap (.bmp) graphics file to be generated can be specified. The created graphics file can be 
viewed or printed with any standard graphics application such as Paintbrush.

The Replay menu item is used to play a Replay battle file that has previously been recorded 
using the Record Battle menu item of the Special Menu. The replay will show in the file all the 
actions that were recorded. A replay can be halted by pressing the Escape key while the replay is 
showing the Hourglass cursor. To restart the replay after it has been stopped, use the Replay 
menu item of the Special Menu.

The Exit menu item is used to exit the program. If the current battle has changed since the last 
time it was saved, then a dialog will appear giving the option to save the battle before exiting.



1.1.2    The Phase Menu

The Phase Menu has the single menu item Next.. Selecting this menu item causes the battle to 
advance to the next phase. The phases are:

Movement Phase
Defensive Phase
Offensive Fire Phase
Cavalry Charge Phase
Melee Phase

In each turn, there are 10 such phases: 5 under the control of the French side and 5 under the 
control of the Russian side. The first side to move in any turn is determined by the parameter 
data associated with the scenario. For example, if the French side is the first to move, then the 10
phases of a given turn would be:

French Movement Phase
Russian Defensive Phase
French Offensive Fire Phase
French Cavalry Charge Phase
French Melee Phase
Russian Movement Phase
French Defensive Phase
Russian Offensive Fire Phase
Russian Cavalry Charge Phase
Russian Melee Phase

At the beginning of a Movement Phase for a given side, internal calculations are performed to 
determine such events as reinforcements, command, rout, rally, and supply. If any events occur 
as a result of these calculations, a dialog appears with a report on these events.

At the end of a turn, the time is advanced by an amount that depends on parameter data 
associated with the scenario and whether the turn is a day or night turn. A day turn is usually 15 
minutes long and a night turn is 1 hour long.



1.1.3    The Units Menu

The Units Menu is used to change the state of Selected units. Before Selecting a menu item 
under the Units Menu, units must be Selected using the Hex Information Area. Most changes to 
Selected units can only occur during the Movement Phase by the controlling side and are subject 
to limitations as a result of the internal rules and movement allowances.

The To Top Of Stack menu item will move the Selected units to the top of the stack. This can be 
done by the controlling side during the Movement Phase.

The To Bottom of Stack menu item will move the Selected units to the bottom of the stack. This 
can be done by the controlling side during the Movement Phase.

The Turn Clockwise menu item changes the facing of the Selected units one hex side in a 
clockwise direction.

The Turn Counterclockwise menu item changes the facing of the Selected units one hex side in a 
counter-clockwise direction.

The Turn About Face menu item causes the Selected units to face in the opposite direction of 
their current facing.

The Change Column menu item changes the current formation of the Selected units between 
Line and Column, or, for artillery units, between Limbered and Unlimbered formation. Changing
into Column formation can be done in both the Movement and Defensive Phases. Changing into 
Line can be done by the controlling side only during the Defensive Phase. (See the Players Guide
for special information applicable to units in Extended Line.) Artillery units can be in Limbered 
or Unlimbered formation. Leaders and Cavalry are always mounted.

The Change Skirmish/Squadron menu item is used to deploy or recall a skirmisher or squadron 
unit. These actions can be performed by the controlling side during the Movement Phase. To 
deploy a skirmisher or squadron, first Select the parent unit and then Select this menu item. To 
recall a skirmisher or squadron, first Select the skirmishers or squadron unit and then Select this 
menu item.

The Change Square menu item is used to change an infantry unit into or out of square formation. 
These actions can be performed by the controlling side during the Defensive Phase with 
undisordered and unrouted units. Note that normally both of these actions can be performed in 
the same Defensive Phase.

The Change Extended Line menu item is used to change an artillery unit of ten or more guns into
or out of Extended Line formation. These actions can be performed by the controlling side 
during the Defensive Phase with undisordered and unrouted units. Extended Line is indicated in 
the Unit List by the presence of a three-line "facing" icon. A unit that changes into Extended Line
will have a second part of the unit deployed in either the left or right flank hex. To convert a unit 
in Extended Line back into normal line formation, both parts of the unit must be in adjacent flank



hexes of the other. One of the two parts is Selected prior to Selecting the Change Extended Line 
menu item. This will rejoin the other part of the unit with the Selected one.

The Remove From Map menu item is used to remove units from the map. This is done to signify 
that these units have moved off the map and are no longer participants in the current battle. 
Before units can be removed, they must be in a hex on the outside boundary of the map.

The Artillery Dialog menu item is used to display the Artillery Dialog. The Artillery Dialog is 
used to Select artillery units to fire during a fire phase.

The Undo Last Movement menu item can be used to undo the last movement or change of 
facing. It can also be used to undo the total move generated by a single Column or Auto 
Movement. Note that a change of formation cannot be undone.



1.1.4    The Melee Menu

The Melee Menu is only used during the Melee phase by the controlling side. To conduct a 
melee attack, a defending hex must first be selected using the right mouse button. A special icon 
is drawn on the selected hex indicating that it is the hex being attacked.

Each group of units that is to attack in this melee must first be Selected using the Unit List and 
then added to the melee using the Add to Melee menu item. Attacking units must be adjacent to 
the defending hex and satisfy all other internal rules for melees.

After all attacking units have been Selected, the melee can be resolved by Selecting the Resolve 
Melee menu item. This will resolve the melee according to the internal rules and a dialog will be 
displayed showing the results of the melee. If the attacking units win the melee, the defending 
units will be displaced from their hex and the attacking units will occupy the defending hex.

The Clear Melee menu item can be used to clear the current melee before it is resolved.

The Show Odds menu item is used to show the current melee odds of attacking strength to 
defending strength.



1.1.5    The Reinforce Menu

The Reinforce Menu is only used in the Movement Phase by the controlling side to display any 
reinforcements that are scheduled or have arrived and are available to be placed on the map. 
Choosing the Scheduled menu item causes the Scheduled Dialog to be displayed. Choosing the 
Arrived menu item causes the Arrived Dialog to be displayed. Choosing the Releases menu item 
causes the Release Dialog to be displayed.



1.1.6    The Status Menu

The Status Menu can be used at any time to display the current strength and losses of the units 
currently on the map, the status of the objective hexes, and the current victory conditions.

Selecting the Strength menu item causes the Strength Dialog to be displayed showing the 
strengths of the organizations on the map.

Selecting the Objectives menu item causes the Objectives Dialog to be displayed showing the 
status of the objective hexes on the map.

Selecting the Leader Casualties menu item causes the Leader Casualty Dialog to be displayed.

Selecting the Victory menu item causes the Victory Dialog to be displayed. This dialog shows 
the points associated with each side for the purpose of determining victory conditions.



1.1.7    The Display Menu

The Display Menu is used to control how information is displayed on the map.

The Units Off menu item toggles the display of units on the map. Turning units off allows for 
better viewing of map details.

The Unit Bases Off menu item toggles the display of bases on the units in the 3D graphics 
modes.

The Unit Flags Off menu item toggles the display of flags on the units in the 3D graphics modes.

The Leaders On Top menu item controls how leaders are displayed on the map. When this menu 
item is checked, the leader symbol will be displayed in a hex whenever a leader unit is present in 
the stack regardless of its location within the stack. When this menu item is un-checked, the 
leader hex symbol will only be displayed in a hex if leaders are the only unit present in the hex.

The Locations menu item displays the Locations Dialog. This dialog allows specific locations on 
the map to be located.

The Visible Hexes menu item toggles the display of Line-of-Sight indicators on the map. When 
this menu item is Selected, all hexes that cannot be seen from the current Hot Spot hex will have 
a blocked line-of-sight icon drawn on them.

The Full Screen Map menu item toggles the display of the Unit List at the bottom of the screen. 
When this menu item is Selected, the Unit List will not be drawn and the full screen area 
available will be used to draw the map. While in this mode, the use of the Selection Dialog 
allows units to be Selected for the purpose of movement and firing.

The Show Organization menu item is used to display the Organization Dialog. This dialog can be
used to highlight a particular organization on the map.

The Find Leader or Units menu item is used to display the Find Unit Dialog. This dialog can be 
used to find specific leaders or units on the map.

The Jump Window menu item is used to display the Jump Window The Jump Window is used to 
quickly jump to another portion of the map.

The Highlight menu item opens a submenu that allows the player to highlight units with certain 
characteristics.

The 2D Normal View menu item is used to display the map in a flat 2D view using normal 
resolution.

The 2D Zoom-Out View menu item is used to display the map in a flat 2D view using lower 
resolution but with more hexes visible at one time.



The 3D Normal View menu item is used to display the map in an isometric 3D view using 
normal resolution.

The 3D Zoom-Out View menu item is used to display the map in an isometric 3D view using 
lower resolution but with more hexes visible at one time.

The 3D Extreme Zoom-Out View menu item is used to display the map in an isometric 3D view 
at an extremely low resolution in which the units are displayed only as blocks.

The Rotate Toolbox menu item toggles the toolbox between vertical and horizontal positions.



1.1.7.1    The Highlight Menu

When the Fixed Units submenu item is checked, all units on the map that are currently Fixed will
be displayed with highlighted outlines.

When the Spotted Units submenu item is checked, all units on the map that are currently Spotted 
will be displayed with highlighted outlines.
When the Low on or Out of Ammo or Uncrewed submenu item is checked, all units on the map 
that are low on or out of ammo and all uncrewed batteries will be displayed with highlighted 
outlines.

When the Fired/Fought Units submenu item is checked, all units on the map that have fired or 
participated in a melee during the current turn will be displayed with highlighted outlines.

When the Moved Units submenu item is checked, all units on the map that have moved during 
the current turn will be displayed with a highlighted outline.

When the Disordered Units submenu item is checked, all units on the map that are Disordered 
will be displayed with a highlighted outline.

When the Detached Units submenu item is checked, all units on the map that are Detached will 
be displayed with a highlighted outline.

When the High Fatigued Units submenu item is checked, all units on the map that currently have 
a Fatigue level of 7 or more will be displayed with highlighted outlines.

When the Extended Line Units submenu item is checked, all units on the map that are in 
Extended Line will be displayed with a highlighted outline.

When the Isolated Units submenu item is checked, all units on the map that are currently Isolated
will be displayed with highlighted outlines.

When the Non-Full Strength Units submenu item is checked, all units on the map that are 
currently at less than their normal full strength in the game will be displayed with highlighted 
outlines.

When the Supply Wagons submenu item is checked, all supply wagons currently on the map will
be displayed with highlighted outlines.

The Organization submenu item can be used to display all units on the map associated with a 
particular organization such as Brigade, Division, or Corps. To use the Organization display 
feature, first Select one or more units on the map using the Unit List. Then Select the 
Organization display feature from the Display menu. This will cause all units with the same 
organization as the organization of the topmost Selected unit to be displayed with a yellow 
outline. For example, Selecting the leader of a brigade or division and then Selecting the 
Organization menu item will cause all units associated with that brigade or division to be 



displayed with the special outline. To turn off the Organization display feature, Select the 
Organization submenu item again.



1.1.8    The A/I Menu

The A/I Menu is used to invoke the Artificial Intelligence capabilities of the program. When A/I 
is in effect, some or all of the decisions for a particular side will be made by the software and the 
software will automatically carry out the appropriate actions such as firing and moving. The A/I 
feature can be used in three modes: Manual, Commander Control, and Automatic. Each mode 
can be applied independently to each side, French and Russian.

In Manual A/I mode, the user makes all decisions for a particular side and is responsible for 
making all moves and firings for that side. This is the default mode.

In Commander Control mode, the user will be prompted for a list of leaders on that side whose 
orders the user will issue manually at the beginning of each turn. The software will automatically
take care of all low-level actions such as moving and firing. In this mode, the user plays the part 
of one or more commanders of that side, but does not have to get involved with the details of 
carrying out the orders.

In Automatic A/I mode, the software takes care of all decisions and actions for that particular 
side. This mode is appropriate when the user wants to take one side and have the software play 
the role of the other side.

An additional option that can be applied to Automatic A/I mode is Fog-of-War. In this mode, 
only the units that can currently be spotted for that side will be displayed on the map. If units 
hidden by Fog-of-War are encountered during a move phase, then they are displayed using 
question mark graphics. These units will be displayed in full detail at the beginning of the next 
phase.

The current A/I mode for a scenario is saved and restored with the battle file. The user uses the 
Resume A/I menu item after the A/I processing has been interrupted by the user to restart the A/I 
processing from the point it was canceled.

The Set Advantage menu item is used to view or change the current Advantage value associated 
with a battle. Advantage values cannot be changed during Modem Play, Play by E-Mail, or Two-
Player Hot-Seat Play however.

The message A/I Control will appear in the Phase display when that phase is under the control of
A/I processing.



1.1.9    The Special Menu

The Special Menu is used for certain special features such as establishing a modem connection 
with another computer and Play-By-E-Mail (PBEM).

In modem play, one computer will be the host and the other computer will be the caller. The host 
is responsible for starting new battles and reading and writing existing battles. The user on the 
caller system is responsible for supplying an encryption key which is used to encrypt the battle 
file on the host system. Battles which are currently being played under modem play are saved 
with the extension .btx and have a different format than ordinary battle files. Battles being played
over a modem may be played either with Fog-Of-War on or off. This option is decided at the 
beginning of the battle by the user on the host system. The Communications Dialog supports a 
chat capability which allows the two users engaged in modem play to communicate with each 
other.

Modem play can also be used with two computers that are connected directly to each other using 
a null-modem cable. In this case, the Null Modem option of the Special Menu should be chosen 
prior to Selecting either the Host or Caller mode.

While using modem play, each computer system will either be under Local Control or Remote 
Control in each phase. While under Local Control, the user can perform actions normally and 
these actions will be communicated to the remote system. While under Remote Control, a user is 
prevented from making changes to the battle and is dependent on the remote system for the 
actions that take place. The current status of Local or Remote Control is listed as part of the 
phase description in the Status Bar.

The Modem Host menu item is used to establish a computer system as the host for modem play. 
After establishing communications parameters, the host system is put into a state where it will 
accept outside calls from the caller system.

The Modem Caller menu item is used to establish a computer system as the caller for modem 
play. After establishing communications parameters, the user on the caller system then specifies 
a phone number to dial and an encryption key to use to encrypt and decrypt battle files. When 
using the Null Modem option, no phone number is required.

To initiate Play by E-Mail, you first Select the Play by E-Mail option in the Special Menu. Next 
you load a scenario by using the New menu item from the File Menu. When starting a new 
PBEM battle, you select the side you want to play, whether you want Fog-Of-War to be in effect,
and the Advantage value to use for the battle. Note that Fog-Of-War and Advantage cannot be 
changed by either side after it is initially set. Once the battle has begun, you play normally until 
you advance the phase to one that is controlled by the other side. At this point, you will be 
prompted for a battle file to save to. Note that all PBEM battle files have the default extension
.bte. After you save the file, you will get a message that the battle file is ready to be E-mailed to 
your opponent. Note: PBEM battle files are plain text, but are in a certain format that is expected 
by the program. When you E-mail the file, you must ensure that your E-mail software does not 
attempt to reformat the file, but rather sends the file in its correct format. In the PBEM battle file 



there are two special lines. One is a header and the other is a trailer line. The header and trailer 
lines are:
----- PEM Header -----
----- PEM Trailer -----
It doesn't cause a problem if your E-mail software adds lines before the header line, such as 
addresses, or lines after the trailer line, such as signatures, as long as the text between these lines 
is not altered.

The first time the other player opens the PBEM battle file, it will ask them if they want to see a 
replay of your turn. This replay will show the other side, within the limits of Fog-Of-War if in 
effect, what you did during your phases. The other player then conducts their phases until they 
advance the phase to one that you control. At that point the PBEM battle file will be saved and 
can be E-mailed back to you.

Note: given that a player can make a copy of the PBEM battle file and replay it as often as they 
like until they determine their best possible outcome, it is impossible to prevent a player from 
cheating during Play by E-mail if that is what they intend to do. It must be understood by both 
sides in Play by E-mail that the contest will be a friendly one undertaken for the enjoyment of the
game and not simply to determine a winner.

The Two-Player Hot-Seat menu item is used to toggle a mode where two players may play each 
other at the same computer with Fog-of-War in effect for each player during their turn. Battles 
being played under this option are saved with the default extension .btt. When control of play 
changes during a turn, the program will clear the map of all units and prompt the next player to 
begin. When the next player is ready, the map will be redrawn with only those units visible to 
that side on the map. The other player should sit so they do not see the screen during the turn. 
Each player will be given the option of seeing a replay of the other player's. turn when they 
begin.

The Record Battle menu item is used to start and stop the recording of play. When recording is 
begun, the user is prompted for a replay file to save the replay information in. Replay battle files 
have the default extension .btr. Selecting the Record Battle menu item a second time terminates 
the recording. Replay battle files can be replayed using the Replay menu item of the File Menu.

The Internet Connection menu item enables modem play across a TCP/IP network. See "7.4 
Network Play" in the Players Guide for details. (Normally you will select Internet play after 
choosing either Modem Host or Modem Caller from the main Menu Screen. However, if you 
wish to initiate Internet play from within the main program, you should Select the Internet 
Connection menu item prior to Selecting Modem Host or Modem Caller in the Special Menu.)

The New Encryption Key menu item is used by the user on the caller system to establish a new 
encryption key. This new key will be used for all subsequent reads and writes of battle files by 
the host system.

The Resync with Remote menu item is used whenever communication problems between the 
host and caller cause the current battles being played on the two systems to get out of sync with 



each other. Either side in modem play can initiate a resync using this menu item. It should only 
be used when the users decide that the current battle has become out of sync.

The Replay menu item is used to restart a Replay battle file that has been stopped by the user.

The Communication Dialog menu item is used to re-establish the Communications Dialog after 
it has been closed by the user. The Communications Dialog is automatically opened once modem
play has been established and will be automatically opened whenever there is chat 
communication from the remote system or if communication lags cause the number of messages 
waiting to be sent to the remote system to reach 20.



1.1.10    The Options Menu

The Options Menu is used to control certain options associated with the main program. The 
setting of these options is saved in the initialization file nir.ini located in the Windows directory. 
Changes to these options will carry over to subsequent executions of the main program.

The Introduction menu item controls the playing of the introductory material at the beginning of 
the main program.

The Prompt for Scenario options controls whether the main program will automatically prompt 
for a new scenario when it is started.

The Beep on Error menu item toggles the option that causes the program to beep when the user 
makes an error.

The Flash Hot Spot menu item toggles the option that causes the Hot Spot indicator to flash on 
the map. Note that the Hot Spot indicator does not flash when in 3D graphics mode.

The Smooth Scroll menu item toggles the option that causes the map to be scrolled smoothly 
when a new Hot Spot is displayed by the main program. When this option is disabled, the map 
will be redrawn directly at the new Hot Spot location without scrolling through the intermediate 
hexes.

The Sound Effects menu item toggles the playing of sound effects associated with various 
actions of the main program.

The Background Music menu item toggles the playing of background music during the different 
phases of the main program.

The Video Effects menu item toggles the playing of video effects associated with various actions 
of the main program.

The Graphical Unit Icons menu item toggles the unit graphics between a graphical representation
and a schematic representation.

The Leader Faces menu item toggles the display of leader units between using actual leader faces
and the use of star symbols.

The Hex Outlines menu item toggles the drawing of hex outlines on the map.

The 3D Dialogs menu item toggles the appearance of the main program dialogs between the 
enhanced 3D appearance and the standard Windows dialog appearance.

The Dialog Help Buttons menu item toggles the appearance of Help buttons in the dialogs used 
by the main program.



The Auto Save menu item toggles the auto-save option. When the auto-save option is in effect, 
the current battle is automatically saved before the phase is advanced except for phases under 
Automatic A/I control.

The Graphics Buffering menu item causes a double-buffering graphics technique to be used 
when drawing the 3D graphics. This greatly reduces the amount of screen flicker caused by 
screen updates, but will reduce the speed of the graphics. Users should use this option as they 
prefer.

The Low Memory Option menu item toggles the special low-memory setting for Windows 3.x 
systems.

The Initial View menu item is used to define the initial view of the map shown when the main 
program is started. This may be set to any of the standard 2D or 3D map views, or it may be set 
so that it is always the view that existed when the program was last closed.

The Optional Rules menu item is used to display the Optional Rules so that those (if any) in 
effect for the current scenario can be viewed.



1.1.11    The Help Menu

The Help Menu is used to get information about how to use the Napoleon in Russia program, 
about the battle being fought, and about the program itself. The General Help menu item invokes
the Windows help program using the Napoleon in Russia general help file. The Scenario Notes 
menu item invokes the Windows help program using a help file specific to the battle. The About 
Napoleon in Russia menu item displays a dialog with certain information about the Napoleon in 
Russia program including version and copyright information.



1.2    The Dialogs
These dialogs are associated with the Napoleon in Russia program:

    1.2.1    The Target Dialog
    1.2.2    The Scheduled Dialog
    1.2.3    The Arrived Dialog
    1.2.4    The Find Dialog
    1.2.5    The Leader Dialog
    1.2.6    The A/I Action Dialog
    1.2.7    The Selection Dialog
    1.2.8    The Jump Window
    1.2.9    The Communications Dialog
1.2.10    The Locations Dialog
1.2.11    The Objectives Dialog
1.2.12    The Strength Dialog
1.2.13    The Organization Dialog
1.2.14    The Artillery Dialog
1.2.15    The Victory Dialog
1.2.16    The Order Dialog
1.2.17    The New Scenario Dialog
1.2.18    The A/I Selection Dialog
1.2.19    The Modem Dial Dialog
1.2.20    The Modem Settings Dialog
1.2.21    The Advantage Dialog
1.2.22    The Optional Rule Dialog
1.2.23    The Leader Casualty Dialog
1.2.24    The Release Dialog



1.2.1    The Target Dialog

The Target Dialog is displayed whenever a hex is fired upon that contains more than one possible
target unit.

The Target Dialog displays the list of possible target units. An entry from the list should be 
Selected by clicking on it with the left mouse button and the OK button pressed. Alternatively, a 
target unit can be Selected by double-clicking on it.

If the Cancel button is pressed, then no firing will occur.

A unit that is dimmed in the Target Dialog is one that is either low or out of ammo or uncrewed if
a battery.



1.2.2    The Scheduled Dialog

The Scheduled Dialog is displayed when the Scheduled menu item of the Reinforce Menu is 
Selected.

The Scheduled Dialog displays a list of units that are scheduled to arrive in the current scenario 
together with each reinforcement group's arrival time, its arrival hex and the percentage chance 
of that reinforcement group arriving on the listed turn. A description of the first unit in each 
group of units is displayed in the list. If there is more than one unit in the group, dots (...) are 
displayed to indicate this. If an entry in the list of units in the Scheduled Dialog is clicked on, 
then the map is scrolled so that the arrival hex becomes the new Hot Spot hex. An asterisk (*) 
preceding a reinforcement group's name in the listing indicates that the group's arrival has been 
delayed. The units in this group may show up at a later turn. Double-clicking on an entry 
displays the names of the individual units that comprise that reinforcement group.



1.2.3    The Arrived Dialog

The Arrived Dialog is displayed when the Arrived menu item of the Reinforce Menu is Selected.

The Arrived Dialog displays a list of units that have arrived and are available to be placed on the 
map. The coordinates of the hex that the units will be placed on is displayed. in the list. A 
description of the first unit in each group that has arrived is displayed in the list. If there is more 
than one unit in the group, then dots (...) are displayed to indicate this.

To place reinforcements on the map, one or more entries in the list are Selected and the OK 
button is pressed. Alternatively, the units associated with a single entry may be placed on the 
map by double clicking on the entry. Units from the selected groups will be placed on the arrival 
hexes and the map will be scrolled to display the last arrival hex.

As reinforcements are placed on the map, they should be moved to other hexes to make room for
more arriving units.

A good way of using the Arrived Dialog is to select all of the units scheduled to arrive in the 
same hex before pressing the OK button. This will place all of these units on the arrival hex and 
facilitate their movement to other locations on the map.

In certain cases, the presence of enemy units in the arrival hex prevents reinforcements from 
being placed in that hex. However, in most cases, arrival hexes are protected. This means that the
placement of reinforcements cannot be prevented by the presence of enemy units on or near the 
arrival hex. The purpose of this rule is to prevent crowding of an arrival hex by enemy units to 
take advantage of the limited movement capabilities near the boundary of the map. The arrival 
schedule associated with a scenario determines if a given arrival of reinforcements is protected 
and the distance used to determine the protection. In general, enemy units should avoid moving 
within 5 hexes of an arrival hex to avoid having the protection mechanism invoked.



1.2.4    The Find Dialog

The Find Dialog is displayed when the Find Leader or Units menu item of the Display Menu is 
Selected. The Find Dialog can be used to determine the location of individual leaders and 
organizations on the map.

To use the Find Dialog, first click in the rectangle labeled Enter search string and type the string 
you wish to search. Note: the search procedure is case sensitive so the search string should be 
entered using the proper combination of upper and lower case. In addition, if the name you are 
looking for contains accent marks, you must either enter these accent marks in the search string 
or pick some substring of the name you are looking for and enter that. If you know that the string
you have entered is unique in the unit names, you can press the Return key after entering the 
string. Otherwise, click on the Search button to see a list of unit names containing the search 
string. These names will be displayed in the list in the upper half of the dialog. To Select one of 
these names, click on it and then click on the OK button.

If the unit found is an individual unit, then the hex containing the unit will become the Hot Spot 
hex and the unit will be Selected in the stack list. The map will be scrolled to place the hex in the
approximate center of the display.

If the unit found is an organization such as brigade, division, or corps, then all units belonging to 
this organization will be displayed with a highlighted border.

Double-clicking on a unit in the Search results closes the Find Dialog and scrolls the map to that 
unit.



1.2.5    The Leader Dialog

The Leader Dialog is displayed when Commander Control mode is Selected for a particular side 
from the AI menu.

The Leader Dialog is used to select those leaders that are to be controlled manually during AI 
processing. If a leader entry is dimmed, then it means that the leader does not participate in the 
current scenario and should not be selected for manual control. For each leader selected for 
manual processing, an Order Dialog will be displayed during AI processing to allow the user to 
select the orders to be issued by that leader for the current turn. All leaders not selected for 
manual processing will have their orders generated automatically during the AI processing.

If no leaders are selected in the Leader Dialog and OK is clicked, the result is the same as fully 
Automatic AI mode.



1.2.6    The A/I Action Dialog

The A/I Action Dialog is used to display the results of A/I processing. By default, the dialog will 
appear in the lower right corner of the screen and the map will be scrolled to bring the 
corresponding portion of the map to the center of the display. The Dialog will reappear in its 
previous position each time it is displayed.

The A/I Action dialog has Step, Run, and Cancel buttons. The Step button is normally the default
and will be outlined in black. The user has the option of clicking on any button with the mouse, 
or of invoking the default button by pressing the Return key. If the user invokes the Step button, 
A/I processing will continue until the next A/I step. If the user invokes the Run button, A/I 
processing will continue until there are no more A/I actions for that phase. Clicking on the Run 
button (which now reads "Pause") a second time while the A/I Action dialog is displayed turns 
this option off. The user can Select the Cancel button to halt A/I processing before it terminates 
for that phase. Alternatively, the user can press the Escape key to cancel the A/I dialog while it is 
visible on the screen. If the A/I dialog is terminated, the Activate A/I menu item from the A/I 
Menu should be Selected later to resume A/I processing at the point it was canceled. The speed at
which the A/I Action Dialog displays the results of A/I processing can be changed. The F5 key 
slows down the processing, the F6 key returns it to normal speed, and the F7 key speeds it up.



1.2.7    The Selection Dialog

The Selection Dialog is displayed when the space bar is pressed. The main purpose of the 
Selection Dialog is to allow unit Selection when the main program is in Full Map mode.

Units are displayed in the Selection Dialog with notation indicating their current strength and 
type of weapon. Units in the list can be Selected using either Single, Multiple, or Extended 
Selection. In Single Selection, a single unit in the list is Selected by clicking on it with the left 
mouse button. Alternatively, a unit can be double-clicked on, which not only Selects the unit but 
closes the Selection Dialog. In Multiple Selection, the left mouse button is clicked on and held 
while the mouse is dragged to Select multiple units. In Extended Selection, the Ctrl key is held 
while individual units are Selected using the left mouse button. Extended Selection is used when 
the units to be Selected are not all together in the list.



1.2.8    The Jump Window

The Jump Window allows the user to go easily from one part of the map to another. The Jump 
Window displays a reduced version of the map with the current portion of the map visible on the 
screen marked off by a rectangle and with the Hot Spot identified by a small square. Clicking on 
a location in the Jump Window with the left mouse button causes the map to be repositioned so 
that the Selected hex is the new Hot Spot and is centered as much as possible in the middle of the
screen. Pressing the Return key instead of left-clicking causes the map to be repositioned so that 
the Hot Spot is centered as much as possible in the middle of the screen.



1.2.9    The Communications Dialog

The Communications Dialog is used to provide communication information to the user during 
modem play and to support chat communication. There are two main windows in the 
Communications Dialog. One of them can be used by the user to type chat communication for 
transmission to the other system. The Remote window is used to display chat communication 
typed by the remote user.

The Queue window is used to display the number of events waiting to be communicated to the 
other side. If this number is 0, then both sides are in sync. The Status window displays a message
indicating the current status of communications between the two systems.



1.2.10    The Locations Dialog

The Locations Dialog displays a list of the map labels and can be used to find specific locations 
on the map. Each map label in the list is followed by its hex coordinates. Clicking on an entry in 
the list causes the map to scroll to the hex location and for that hex to be made the Hot Spot.



1.2.11    The Objectives Dialog

The Objectives Dialog displays a list of objectives, their value, and which side is currently in 
possession of the objective. Clicking on an entry in the list causes the map to scroll to the 
objective hex location and for that hex to be made the Hot Spot. If an objective hex is not 
currently occupied, then possession of the hex is based on which side last occupied the hex.



1.2.12    The Strength Dialog

The Strength Dialog is displayed when the Strengths menu item of the Status Menu is Selected.

The Strength Dialog displays a list of the organizations associated with each side and the current 
number of men on the map for each of these organizations. In this calculation, artillery batteries 
count as 25 men for each gun.



1.2.13    The Organization Dialog

The Organization Dialog is displayed when the Show Organization menu item of the Display 
Menu is Selected.

The Organization Dialog displays a list of the organizations associated with each side. Clicking 
on an organization in this list causes all units currently on the map associated with this 
organization to be highlighted.



1.2.14    The Artillery Dialog

The Artillery Dialog allows artillery to be Selected and fired during the fire phases. To fire a unit 
which is displayed in the Artillery Dialog, first Select the unit in the list using the left mouse 
button, and then click on the target hex with the right mouse button.



1.2.15    The Victory Dialog

The Victory Dialog displays the current state of the victory conditions. The number of infantry, 
cavalry and artillery lost by each side and the point value associated with this loss is displayed. 
The Objective points held by the "First Side" (generally the side that moves first in the scenario) 
are also displayed. The total victory points amassed by the "First Side" are calculated as follows: 
total Objective points held by the "First Side" plus the point value of the opposing side's unit 
losses, minus the point value for the "First Side's" unit losses. The range of values used to 
determine victory and the "First Side's" level of victory at that point in the battle are also 
displayed.



1.2.16    The Order Dialog

The Order Dialog allows the user to specify the orders for a leader when a particular side is in 
Commander Control A/I Mode. The Order Dialog lists the organization that the leader is 
currently in command of, plus all of the subordinate organizations. As an organization is 
selected, information about the organization and any order currently given to the organization are
displayed. The information displayed about an organization includes the size of the organization 
in strength points, the percentage of those units that are currently in good order, and the center 
location of the organization. Reinforcements that have not arrived have their entry hex as their 
location.

The first order shown in the Order Dialog is the order that has been generated by his superior for 
that leader to carry out. It is up to the leader to then assign orders to his subordinate organizations
to meet that objective.

Orders can be given to the selected organization using the Order Dialog and the map. The type of
order is first selected from the list shown. Once the type of order is selected, the objective hex is 
selected by. clicking on the map hex with the right mouse button.

The Order Dialog is redisplayed at the beginning of each player turn. Existing orders can be left 
unchanged by clicking on the OK button. Clicking on the Cancel button cancels the A/I 
processing at that point. The A/I processing can be resumed by using the A/I menu or clicking on
the A/I button in the toolbox.



1.2.17    The New Scenario Dialog

The New Scenario Dialog is used at the beginning of a scenario that is going to be played using 
the modem or Play-By-E-Mail to define which sides each user will be playing and whether Fog-
of-War will be in effect for the battle. If Fog-of-War is assigned at the beginning of the battle, it 
cannot be disabled during the battle.

The Rules button causes the Optional Rule Dialog to be displayed so that the optional rules for 
the scenario can be Selected.



1.2.18    The A/I Selection Dialog

The A/I Selection Dialog allows the A/I setting of a scenario to be set at the beginning of the 
scenario. For more information on the A/I settings, see the A/I Menu. The dialog also allows the 
initial Advantage value of the battle to be set.

The Rules button causes the Optional Rule Dialog to be displayed so that the optional rules for 
the scenario can be Selected.



1.2.19    The Modem Dial Dialog

The Modem Dial Dialog is used by the caller system in modem play to dial the host system and 
to specify the encryption key to be used when reading and writing modem battle files on the host 
system. The encryption key chosen by the user on the caller system should be kept secret to 
prevent other users from reading the modem battle file on the host system.



1.2.20    The Modem Settings Dialog

The Modem Settings Dialog is used to configure the modem before starting modem play. The 
values set in this dialog are saved in the Napoleon in Russia initialization file nir.ini and restored 
in subsequent executions of the main program.

The Initialization string is sent to the modem before any other commands. This command resets 
the modem back to its initial state. The default value of this string is ATZ.

The Dial Prefix string is sent to the modem just prior to dialing the remote phone number. The 
default value of this string is ATDT.

The Dial Suffix string is sent to the modem just after dialing the remote phone number. The 
default value of this string is empty.

The Escape string is sent to the modem to cause it to go off-hook just prior to hanging up. The 
default value of this string is +++.

The Hangup string is sent to the modem to cause it to hang up the phone and put it in a state 
where it will not auto-answer. The default value of this string is ATHS0=0.

The Auto Answer string is sent to the modem to put it in a state where it will auto-answer any 
incoming call. The default value of this string is ATS0=1.

The Baud Rate setting in this dialog establishes the baud rate of the communication between the 
computer and the modem. This setting should correspond to the highest speed supported by the 
modem. For modems that support 28.8Kb, the baud rate should be set at 38400.

The Port setting in this dialog should correspond to the port that the modem is connected to.

The Timeout setting determines how long the communication code will wait after issuing a 
modem command for a reply from the modem. The default timeout value is 30 seconds.



1.2.21    The Advantage Dialog

The Advantage Dialog is used to view or change the current Advantage value associated with a 
battle. Once set, advantage values cannot be changed during Modem Play or Play by E-mail.



1.2.22    The Optional Rule Dialog

The Optional Rule Dialog is used to view or change the Optional Rules in effect for the current 
scenario. Optional rules can be changed only when a new scenario is started. Once set for a 
scenario, they cannot be changed. When optional rules are Selected in the Optional Rule Dialog, 
they become the default for all subsequent new scenarios.



1.2.23    The Leader Casualty Dialog

The Leader Casualty Dialog displays a list of leaders who have become casualties during the 
current scenario. To the left of each leader's name is a code indicating the type of casualty. A K 
indicates the leader was killed, a W indicates that he was wounded, and a C indicates that he was
captured. Clicking on a leader's name in the dialog causes the map to scroll to the location where 
he became a casualty.



1.2.24    The Release Dialog

In certain scenarios, units may begin in a Fixed state, which prevents them from moving from 
their initial position. Depending on the scenario, certain releases from this fixed state may exist 
from a certain time onward, which allow the units to become unfixed and thereby able to move 
normally. The Release Dialog is used to view any releases that may be scheduled in the current 
scenario and the probability of these releases occurring.

Clicking on an entry in the Release Dialog causes that organization to become highlighted on the
map. Double-clicking or Selecting OK causes the Release Dialog to be closed and the 
organization to remain highlighted. Selecting Cancel causes the organization to become 
unhighlighted.



1.3    The Hex Information Area
The Hex Information Area is displayed below the map. The Hex Information Area is used to 
display information regarding the current Hot Spot. A hex is Selected to be the Hot Spot by 
clicking in the hex with the left mouse button or as a result of placing reinforcements in the hex. 
The Hot Spot hex is indicated on the map with a red outline. The Hex Information Area contains 
three parts:

1.3.1    The Unit List
1.3.2    The Terrain Information Area
1.3.3    The Status Bar



1.3.1    The Unit List

The Unit List displays the units in the Hot Spot hex. All units in the Hot Spot hex may be 
Selected by double-clicking in the Hot Spot hex with the left mouse button. Alternatively, an 
individual unit may be Selected by left-clicking on its entry in the Unit List.

When the program is in Full-Screen Map mode, the Unit List is not displayed. In this mode, the 
Selection Dialog is used to Select units on the map.

A list showing the complete location of a unit in the order-of-battle, and that unit's normal full-
strength value in the game (if it is currently below full strength), can be displayed by clicking on 
the unit in the Unit List with the right mouse button.

For each leader in the Hot Spot hex, three values are shown in the Unit List. The C value 
represents the Command Rating of the leader. This value determines the ability of the leader to 
command the organizations under his command. When a Brigade leader is currently Detached, 
an icon will appear behind his Command Rating when he is Selected. Being detached occurs 
when a Brigade leader is outside the command radius of his Division commander. The L value 
represents the leader's Leadership Rating. This value determines the ability of the leader to rally 
routed units under his command. The M value represents the leader's movement allowance. This 
value will change depending on how far the leader has moved in the current movement phase. A 
gold star in a leader's picture indicates that he has been promoted to the command of the next 
higher level in his organization.

For each regiment and battery in the Hot Spot hex, 5 values plus associated icons are displayed 
in the Unit List. The S value is the current strength of the unit. For infantry and cavalry units, the
strength value is the number of men. For artillery, the strength value is the number of cannon. 
The RG value is the firing range of the unit. The MV value is the movement allowance of the 
unit. The QL value is the Quality rating of the unit. This value will determine how easily the unit 
routs and how quickly it will rally after routing. Quality values range from 9 (best) to 1 (worst). 
The FA value is the fatigue level of the unit. As a result of combat, the fatigue level of a unit will 
increase up to a maximum value of 9. When the fatigue level of a unit reaches 4, it will be more 
likely to rout as a result of combat. This penalty will increase again when the fatigue level of the 
unit reaches 7. To be eligible to recover from fatigue, a unit must not move, fire, be fired upon, 
or participate in melee for one complete game turn.

Certain icons are displayed in the Unit List to indicate various states associated with units. A full-
color bullet icon indicates that the unit can fire or attack in melee in the current phase. A brown 
bullet icon indicates that the unit has fired or attacked in melee in the current phase. A half-color 
bullet icon indicates that the unit is low on ammo. This state prevents the unit from firing in the 
Offensive Fire Phase. A hollow bullet icon indicates that the unit is out of ammo, or, in the case 
of artillery, that the battery is uncrewed. This state prevents the unit from firing in all fire phases. 
The weapon type of the unit is displayed in a brown square in the icon display area. See the 
Scenario Notes help file for more information on weapon types. A full-color wheel icon indicates
that the unit can move in the current Movement Phase. A brown wheel icon indicates that the unit
has moved some but not all of its movement allowance. A red D icon indicates that the unit is 



disrupted. A red R icon indicates that the unit is routed. An S icon denotes a skirmisher unit. A 
full-color binoculars icon indicates that the unit is currently spotted by an enemy unit. A brown 
binoculars icon indicates that the unit is spotted only by an enemy supply wagon.



1.3.2    The Terrain Info Field

The Terrain Info field displays the terrain in the Hot Spot hex. The possible terrain types are 
Clear, Forest, Orchard, Building, Village, Rough, Marsh, Water, Ford, Bridge and Blocked. 
Following the terrain type is a value indicating its defensive benefit. On the second line of the 
Terrain Info field is the elevation of the hex in meters. The third line indicates the Objective 
value of the hex (if any). The fourth line shows the current artillery ammunition supply for each 
side, in the format "Russian/French".



1.3.3    The Status Bar

The Status Bar appears at the bottom of the main program window. The Status Bar is used to 
display informational messages and the map coordinates of the current Hot Spot hex.

The Status Bar contains scroll buttons that allow the Unit List to be scrolled to the left and right 
whenever there are more units in the current hex than can be displayed.



1.4    Other Features
Other features associated with the main program are:

1.4.1    Using The Mouse
1.4.2    Accelerators
1.4.3    Column and Auto Movement
1.4.4    The Toolbox
1.4.5    Advantage
1.4.6    Optional Rules



1.4.1    Using The Mouse

The mouse is used to get information on the units and terrain on the map and to control the 
actions of units on the map.

Single-click with Left Mouse Button: This will display information on the units and terrain in the
designated hex. This action can be performed on any hex during any phase.

Double-click with Left Mouse Button: In addition to displaying information on the units and 
terrain in the designated hex, this action also Selects all units in the Unit List. This is commonly 
done before moving units, having them fire, or using them in a Melee attack.

Single-click with Right Mouse Button: The result of this action is dependent on the current 
phase.

1. During the Movement Phase, this action causes the units Selected in the Unit List to be moved
to the designated hex

2. During a Fire Phase, this action causes the units Selected in the Unit List to fire on the 
designated hex. If there is more than one potential target in the target hex, a dialog will be 
displayed that allows for the selection of the target.

3. During a Melee Phase, this action causes the Selected hex to be designated as the defending 
hex. After this has been done, adjacent units can be designated as attacking units using the Left 
Mouse Button, Selecting from the Unit List, and adding them to the attack using the Melee 
Menu.



1.4.2    Accelerators

The main program supports the use of the following accelerators:
Ctrl-N - advance to next phase
Ctrl-U - undo last movement
Ctrl-X - move Hot Spot to Next Stack
Keypad 0 - change formation of Selected units
Keypad 1 - move Selected units down and left
Keypad 2 - move Selected units down
Keypad 3 - move Selected units down and right
Keypad 4 - turn Selected units counterclockwise
Keypad 5 - turn Selected units about face
Keypad 6 - turn Selected units clockwise
Keypad 7 - move Selected units up and left
Keypad 8 - move Selected units up
Keypad 9 - move Selected units up and right
Left Arrow - scroll map to the left
Right Arrow - scroll map to the right
Up Arrow - scroll map up
Down Arrow - scroll map down
Shift - display location names on the map
Delete or Ctrl-L - turn Selected unit icons counter-clockwise
Page Down or Ctrl-R - turn Selected unit icons clockwise
Home or Ctrl-F - move Selected unit icons forward
End or Ctrl-B - move Selected unit icons backward
F1 - open general help file
F2 - open scenario notes file
F5 - slow down A/I Action Dialog processing
F6 - return A/I Action Dialog processing to normal speed
F7 - speed up A/I Action Dialog processing



1.4.3    Column and Auto Movement

Column and Auto Movement can be used to facilitate the movement of individual units and 
groups of units. These features are most useful when moving recently arrived reinforcements to 
the scene of battle.

Auto Movement is used to move units automatically from one location to another on the map 
without having to specify all the intermediate hexes. To use Auto Movement, you first Select the 
unit(s) to be moved in the normal way, using the left mouse button or making the Selection in the
Unit List. You then click on the target hex using the right mouse button while holding down the 
Alt key. This causes the program to determine a minimum-distance path to the destination hex 
and to move the Selected unit(s) along that path up to the limit of the movement allowance. Auto
Movement is particularly useful when combined with Column Movement.

Column Movement allows the movement of a column of units in a coordinated manner by 
merely specifying the destination hex of the lead unit. The Column Movement feature will 
ensure that the trailing units in the column will move in a "follow-the-leader" fashion. Column 
Movement can be used in two modes: Chain Column Movement and Organization Column 
Movement.

Chain Column Movement is used when you want to move a column of units together without 
consideration for which brigade, division or corps the units belong to. This is most useful when 
you are bringing newly arrived reinforcements onto the map from the arrival hex. Chain Column 
Movement is not useful when moving units in a "crowd", where the question of which unit to 
move next in the column can be ambiguous.

To use Chain Column Movement, the Hot Spot must be located on the hex containing the lead 
unit(s), but no units in the Unit List can be Selected. You then click on the adjacent target hex 
using the right mouse button while holding down the Ctrl button. Column Movement will 
automatically move the topmost non-Leader unit in the stack, together with all Leaders above 
this unit, to the target hex. If this movement empties the original hex, then the Column 
Movement feature will pick a unit from an adjacent hex and move it into the original hex. This 
process of picking a unit from an adjacent hex is then repeated as long as the movement creates 
an empty hex. Note that Chain Column Movement will fail when there is more than one choice 
of unit to move into the empty hex.

Organization Column Movement is used when you want to move a column of units together 
using the common organization of the units as the factor determining which units to move. 
Organization Column Movement is useful when you want to move a particular brigade, division, 
or corps as a group.

To use Organization Column Movement, the Hot Spot must be located on the hex containing the 
lead units and some or all of the units in the Unit List need to be Selected. The organization of 
the topmost Selected unit will be used to determine which organization is being moved. For 
example, if the Leader of a brigade is the topmost Selected unit in the Unit List, the Organization
Column Movement feature will move only units from that brigade. To invoke the Organization 



Column Movement feature, you then click on the adjacent target hex using the right mouse 
button while holding down the Ctrl key. The Organization Column Movement feature will move 
the topmost non-Leader Selected unit into the target hex together with all Selected Leaders above
it. If this movement empties the original hex, a unit in an adjacent hex from the organization 
selected will then be moved into the original hex. This process will be repeated as long as the 
movement produces an empty hex. The Organization Column Movement feature will fail if the 
choice of which unit to move into the empty hex is ambiguous.

Both forms of Column Movement can be combined with Auto Movement. To use both Column 
and Auto Movement, you hold down both the Ctrl and the Alt keys while clicking on the target 
hex with the right mouse button. If no units in the Hot Spot hex have been Selected, then Chain 
Column Movement will be used to move the column along the minimum path towards the target 
hex. If units in the Hot Spot hex have been Selected, then Organization Column Movement will 
be used to move the units.



1.4.4    The Tool Box

The Tool Box is a floating box of buttons that can be used to facilitate certain actions of the main
program. The buttons in the box and the action they perform are:

Next - Advance to the next phase

Zoom - Toggle display between Normal and Zoom-Out view

Counterclockwise - Turn the Selected units counterclockwise

Clockwise - Turn the Selected units clockwise

About Face - Turn the Selected units about face

Change Formation - Change the formation of the Selected units

Skirmisher/Squadron - Deploy or recall a skirmisher or squadron unit

Square - Change the Selected units into or out of square formation

Units - Toggle the display of units on the map

Bases - Toggle the display of unit bases on the 3D map

Artillery - Display the Artillery Dialog

Melee - Resolve the current melee

Display Low Ammo - Highlight units that are low or have no ammo, or are uncrewed

Display Spotted - Highlight spotted units

Display Moved - Highlight units that have moved

Display Fired/Fought - Highlight units that have fired or fought

Display Disrupted - Highlight units that are disrupted

Display Org - Highlight units in same organization as Selected units

Full Map - Toggle Full Map mode

Visible Hexes - Toggle the display showing hexes visible from the current Hot Spot hex

Objectives - Toggle the display of objective hexes on the map



Jump Window - Display the Jump Window

Next Stack - Jump to the next stack to be processed

A/I - Complete current phase under A/I

Command hints for each toolbox button are displayed in the status bar at the bottom of the main 
window when the button is pressed and held down. Moving the cursor off the button without 
releasing the mouse button clears the command hint.



1.4.5    Advantage

The Advantage feature can be used to give one side or another a combat advantage during a 
battle. The advantage value is set at the beginning of the battle using either the A/I Selection 
Dialog or the New Scenario Dialog Advantage values can range from 0 to 100 for either side. 
The default value of 0 means that neither side will get an advantage. Giving an advantage value 
to a side means that combat losses for that side will be reduced below normal and combat losses 
for the other side will be increased above normal. Advantage values can be viewed and changed 
using the Advantage Dialog.



1.4.6    Optional Rules

When a new scenario is started, Optional Rules may be selected for that scenario. Once set for a 
scenario, they cannot be changed.

The Cavalry Counter-Charges optional rule allows cavalry to make charges against enemy 
cavalry during the Defensive Phase. Counter-Charging cavalry must not be disordered or routed 
at the time of the charge. Enemy cavalry must have moved in the preceding Movement Phase in 
order to be a valid target of a Counter-Charge. To Counter-Charge with cavalry, the cavalry must 
first be Selected. Next the target hex is selected either by right-clicking on the hex or by dragging
and dropping the Counter-Charging cavalry to that hex. If successful, the Counter-Charging 
cavalry will automatically be moved to the target hex and a melee will be resolved there 
immediately.

The Victory Points for Leader Casualties optional rule causes points to be awarded for the loss of
leaders. These points are displayed in the Victory Dialog.

The Rout Limiting optional rule causes a morale modifier to be used when determining the 
spread of routing to other units so as to reduce the frequency of multi-unit routs.

The Isolation Rules optional rule penalizes units that cannot trace a line of hexes free of enemy 
units and uncontested enemy zone of control to a board edge. (Enemy zone of control can be 
negated by the presence of a friendly unit in a hex.) An Isolated unit defends at half strength in 
melee. When a unit is Isolated, a red rectangle appears behind its Strength value in the Unit List. 
An Isolated artillery unit can run low on or out of ammunition in the same manner and with the 
same effects as infantry. (The artillery unit becomes resupplied when no longer Iisolated, 
provided its side's ammo pool is greater than zero.) An Isolated leader receives no benefits from 
his superiors during command checks. Russian units, except for cossacks and leaders, are 
immune to Isolation.

The Extreme Fog-of-War optional rule hides each unit's name, quality, exact strength and current
movement allowance from the opponent. Leaders under Extreme FOW have all data hidden from
the opponent.

The Partial Retreats optional rule allows a unit forced to retreat from a melee into an 
overstacking situation to lose a portion of its strength in order to allow it to retreat into the hex 
instead of being completely eliminated due to overstacking.

When the Line Movement Restriction optional rule is in effect, infantry units can change into 
line formation normally, but attempts to move while in line formation will result in Disorder.




